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Introduction 
Microsoft Visio is a diagramming tool that helps technical writers (and members of many other 

professions) create visual aids, which can drastically simplify an explanation of how to use a product or 

service. Conciseness, clarity, and accuracy are key elements of technical writing, and a good diagram can 

help you realize those goals more fully. Implementing diagrams appropriately can save you time to focus 

on areas which need a thorough written explanation.   

The following list presents a few examples of visuals that you might need to create as a technical writer: 

• Decision-making flowcharts 

• Network diagrams 

• UML diagrams 

• Brainstorming maps 

Program Overview 

Visio’s template versatility makes it useful both during the brainstorming phase of a project and in the 

creation of a visual that you can include in the final version of the project. In fact, as per Microsoft’s 

website, Visio’s three main applications are in the creation of diagrams, ‘flows,’ and planning [tools].  

In short, Visio has several capabilities and features that make it an excellent tool to have in your belt –

it’s up to date on Business Process Model and Notation (BPMN) industry standards, for instance, and 

you can integrate it with other apps such as Power BI or Teams to enhance its functionality, especially in 

automating processes and co-authoring in real time.  

Microsoft also offers a few different Visio plans so that you can pick the version of the application which 

will suit your project best. Appendix A contains a comparison on the differences between these plans 

and versions of Visio. Before that, though, this guide will introduce you to the web version of Visio and 

teach you how to set up a hub and spoke model, a flowchart, and a Venn diagram. 

Navigating the Home Screen 
When you launch the web version of Visio, you will arrive at the home screen, depicted in Figure 1. 

 

Figure 1: Microsoft Visio Home Screen 
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On the left side of the home screen is the Microsoft Office Toolbar, which you may not see unless you 

have Visio through the Microsoft Office 365 plan. This toolbar lets you quickly switch to other Microsoft 

apps and manage your project creation throughout the entire Microsoft Office suite.  

At the top of the screen is a search bar, and in the top right corner, you can find the program settings, a 

help bar, and your account profile. In the settings menu, one of the things you can do is change the 

language or time zone that you want the program to use. The help panel will show you how to execute 

simple functions in Visio, such as adding and connecting shapes. Finally, your account profile will let you 

either access your account information or sign into a different account.  

 

                               Figure 2: Settings Menu 

 

                                  Figure 3: Help Panel 

In the New category on the top third of the screen, Visio recommends some popular 

templates to help you get started in creating a new project. It also provides a blank 

drawing option, and a More templates hyperlink that will let you see an expanded 

list of templates.  

In the Recommended category located on the bottom of Figure 1, Visio will start a collection of the 

most recent projects that you’ve worked on. If you scroll a little bit further down the screen, you will see 

a list version of your most recent projects, and an additional list of search filters to help you locate the 

exact project you’re looking for, new or old. 

Figure 6: Search Filters in the Recommended Category 

Figure 4: M. 
Office Toolbar 

Figure 5: More 
Templates Hyperlink 
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Ch. 1: Setting up a Project from a Template 
There are 11 template categories to choose from in Visio. All told, these are: 

1. Basic Diagrams 

2. Basic Flowcharts 

3. Organization Charts 

4. Block Diagrams 

5. Basic Network 

Diagrams 

6. Process Diagrams 

7. Business Matrixes 

8. Venn Diagrams 

9. Cycle Diagrams 

10. Pyramid Diagrams 

11. Infographic Timelines 

So how do you know which one to choose for your project? The good news is that these are still just 

templates, meaning that even if you pick one that is a bit ill-suited for the scope of your project, you can 

customize it. Templates are mainly there to provide a starting reference point and automate some of 

the tedious form creation that comes with setting up the same kind of diagram repeatedly.   

We will set up our own example project in Visio to better understand how to customize a project using a 

template as a base. For this example, we are going to use the Hub and Spoke Model template.  

A hub and spoke model is a diagram that demonstrates how several small regional distribution centers 

(spokes) connect to one big national distribution center (the hub) to organize the flow of products or 

connect customers to a location which offers the service they are looking for. Two examples of 

industries that use the hub and spoke model are the air travel industry and the shipping industry.  

Consider restaurant chains as well – each restaurant started out in one central location, and then chains 

spread out across the surrounding area to offer service to more customers. In our example, we will 

depict how a few local Austin MAD Greens chains connect to the restaurant’s central Austin location – 

and how that location connects to the original store in Colorado.  

Opening a Template 
To initialize our document, we must first select and open the template we would like to modify. 

Reference Figure 7 for a guideline and perform the following steps:   

1. First, click More templates to pull up the full list of categories on your screen.  

2. Click See All at the top right of the Basic Diagram category or click the rightward-facing arrow on 

the right-hand side of the category to locate the correct template.  

3. Press the Create button to open the template in a new Visio canvas. 

Note: The document will save automatically in the web version of Visio. Regardless, every so 

often it is prudent to save your work manually (Ctrl + S). 

 

Figure 7: Hub and Spoke Model in the Basic Diagram Category 
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Replacing the Placeholder Text 
Now that we have the template loaded in successfully, we’ll remove the irrelevant text and put in our 

own. These are the steps you must take to replace placeholder text in Microsoft Visio:  

1. With your cursor, hover over the node containing the text you want to replace. 

2. Double-click the node in quick succession to open the textbox.  

3. Type in your replacement text. 

4. Click anywhere on the screen outside of the textbox field to close it.  

To update the default model so that it better reflects the scope of our project, apply the 

strategies from the list above to perform the following changes: 

1. Change the model’s title from “Distribution HUB And Spoke Model” to “MAD Greens HUB And 

Spoke Model.” 

2. Fill in the short description located underneath the title with the text “Branch Locations 

Reporting to Central.”  

3. Replace “Central Distribution” with “Colorado” in the node at the very center of the model. 

4. Change the text “Regional Distribution Center” in two of the supporting spokes to “Arizona” and 

“Texas” respectively.  

When you have completed these changes, your model should mirror Figure 9 below.  

   

                                                 Figure 9: Nodes Established 

Figure 8: An Open Textbox 
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Removing Extraneous Nodes 
As you may have noticed in the image above, we have four supporting nodes (or “spokes”) that we are 

not using. Follow these steps to delete each of the unnecessary nodes:  

1. Left click the node that you wish to delete to make sure that it is selected. 

2. Next, right click the node and select Delete from the drop-down list.  

Note: Each node consists of three elements: shape, textbox, and connective line. To simplify the 

deletion process, you will want to double-check that you have all three parts of the node 

included in your selection. So, after you’ve left-clicked the node you want to delete initially, 

make sure that the circles that appear in your selection box are completely empty. If the circles 

have a grey slash through them, this means that only the shape and the textbox are selected. If 

this is the case, simply left click the shape again to add the line to your selection.  

 

Figure 10: Selection in Need of Correction 

 

Figure 11: Selection with Slashes Included 

We you have finished with the steps above, we should only have three nodes remaining: Colorado, 

Arizona, and Texas. 

Adding Subordinate Nodes 
The last task we need to complete for our project is to add the Austin MAD Greens locations as 

subordinate nodes splintering off the Texas node. To add these subordinate nodes to your model, 

reference Figure 12 for additional clarity, and complete the following steps:  

1. Hover over the Texas node with your cursor until four grey directional 

arrows appear.  

2. Move your cursor over the directional arrow to the right of the Texas node 

and select the circle shape from the small menu that appears. 

3. Double-click the new circle node that you added to open its textbox. 

4. Type in “Austin Lakeline” to give the new supporting node a label.  

5. Click anywhere outside of the textbox to close it.  

6. Next, right click the “Austin Lakeline” node to open the drop-down menu.  

7. Click the arrow next to Shape Fill to open that menu as well. 

8. From the shape fill menu, select Accent 4 to change the color of the 

subordinate node.  

9. To resize the subordinate node, grab one of the corner boxes of the 

selection, drag your mouse diagonally towards the opposite corner of the circle, and then 

release your mouse.  

Figure 12: Creating a Subordinate 
Node 



5 
 

Repeat these steps two more times to add the other two supporting nodes around the Texas node. The 

only deviations you should need to make from the list of steps above are to select a different directional 

arrow extending from the Texas node, and to change the label text from “Austin Lakeline.”  

The two new labels you add should be:  

• “Austin Bergstrom International” – add this node to the south of the Texas node. 

• “Round Rock” – add this node to the left of the Texas node. 

Repositioning Nodes and Changing Font Size 
You may need to rearrange the nodes a little so that they do not carry over to the next page. To do so, 

select each node and drag it with your mouse to the place where you would like to reposition it.  

We should also change the font size of the Texas and Arizona nodes so that all the text is the same size. 

To do so, complete the following steps:  

1. Double-click the node to open the textbox. 

2. Press Ctrl + A on your keyboard to select all the text within the textbox.  

3. Select the drop-down arrow next to the Font Size box located inside the toolbar at the top 

middle of the screen. Change the font from “12” pt. to “10” pt.   

When you’ve repositioned the nodes and decreased the font size, your model should mirror Figure 13.  

 

                                            Figure 13: Finished Model 

Congratulations! You’ve created your own diagram from a starting template. Reference Ch. 3: Exploring 

Menu Options or Appendix B: Further Reading to learn what else you can do with your new diagram.   
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Ch. 2: Starting a Project from a Blank Document 
Creating a project from a blank document is a great way to learn all of Visio’s tools. Within this chapter, 

we’ll set up an example flowchart to demonstrate how to construct your own visual aids from scratch. 

The topic of our flowchart will be decision-making steps when editing a document for peer review.  

Flowcharts are visual aids that catalogue the steps in a process chronologically. They can also display 

how each step can re-route to other steps dynamically – i.e., when there is a yes or no answer to a step, 

the chart must diverge to accommodate the different answers. As such, flowcharts are often seen in 

troubleshooting and other areas of process documentation. They can be used to categorize department 

responsibilities in a workflow, to provide onboarding for a new type of task, and much more. 

Components of a Flowchart 
Before we can create a flowchart, we first need to know what all the symbols mean. Our hub and spoke 

model consisted primarily of circles and arrows, but flowcharts typically include start and end points, 

decisions, processes, and much more. Figure 14 below will identify the basic elements of a flowchart.  

Symbol Meaning 

 Ellipses are used to mark the start and end points 
of a flowchart. These points are sometimes 
referred to as “terminators.” They are meant to 
give users a clear indication of when to start 
paying attention and when to stop.  

 Arrows act as connectors between the steps in a 
flowchart, indicating what order to complete the 
tasks in and which shapes relate to one another. 
Connectors add context to the rest of the 
flowchart, demonstrating relationships between 
information.  

 Rectangles represent processes – i.e., the 
individual steps a user will take to execute the 
overall function the flowchart is meant to teach 
them how to do. In other words, a process tells 
the user what kind of action they’ll need to take 
to proceed. “Draw a rectangle” is one example.   

 Diamonds represent a decision point (answerable 
by a yes or no question) in the flowchart which 
may reroute the user from the mainline path. In 
some cases, the splinter path may eventually 
rejoin the mainline path.  

 A rectangle with two dividing lines is referred to 
as either a “subprocess” or a pre-defined process. 
A pre-defined process appears earlier in the 
flowchart as a process node, whereas a 
subprocess is a sub-step compared to a process 
node.  

Figure 14: Common Flowchart Symbols 
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Initializing the Workspace 
From Visio’s home screen, click New blank drawing to open a new document. You can also click 

Open in Desktop App if you would prefer to work on your document with the Visio application 

itself, but for this project, we’ll stick with the web version of Visio.  

The first thing we’ll check is the size and orientation of our workspace. This is typically set up for 

us automatically when we open a new document, but it’s still a good idea to familiarize yourself 

with these settings in case you’d like to change them later. Follow these steps to set up your 

workspace in preparation for the flowchart:  

1. Click the Design tab in the top left toolbar.  

2. Click the arrow next to Orientation to open the drop-down menu and select Portrait 

from the options.  

3. Click the arrow on the right of Size to open the drop-down menu and click Letter to 

select it.  

Next, we’ll want to add basic flowchart shapes to our quick toolbar, located on the left 

edge of the screen. This toolbar, visible to the right in Figure 15, is called the Palette in 

Visio. Adding flowchart shapes to it will enable us to select industry standard shapes 

without having to search for them every time we need a new instance.  

To add flowchart components to your palette, perform the following steps:  

1. Mouse over to the bottom of the palette and click Add Shapes to bring up the 

menu. 

2. Scroll down to Basic Flowchart Shapes and click the Add button (see Figure 16).

Adding Shapes to Your Flowchart 
First, we’ll want to add our starting point to our flowchart. Complete the following:  

1. In the palette, click Basic Flowchart Shapes to open the menu.  

2. Click and hold down on the Start/End shape to drag it across your screen, 

then let go of your mouse to drop the shape at the top of your workspace.  

Note: After you place the shape, you may find that it looks quite small on 

your screen. Click the + (plus) icon on the bottom right of the workspace 

to zoom in on the document and get a better view of what you’re working 

on. You can click the – (minus) icon to zoom back out or use the Slider to 

adjust your overall zoom ratio. Finally, you can click Fit page to current 

window to fit the entire flowchart on your screen so that you can see 

everything at once.  

3. Double click the shape to open the textbox, and type “Start” as the label.  

4. Click somewhere outside of the textbox to close it.  

 

Figure 15: The 
Palette 

Figure 16: Adding Flowchart 
Shapes 

Figure 17: Adding the 
Terminator 
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Repeat this process as necessary to add the rest of the steps to the flowchart, being careful to use the 

correct shapes depending on what type of step the entry is. Remember, after you have configured the 

initial starting point of the document, you can skip steps 1 and 2 by hovering over one of the directional 

arrows relative to the node and selecting the type of shape you want to insert next (see Figure 12). This 

will also spare you from having to go back and add in connective arrows manually.  

Reference the following list to finish filling out the flowchart:  

1. To the south of the “Start” node, add a process node with the label “Open the document you 

need to review.”  

Note: You do not need to punctuate the labels in the flowchart.  

2. To the south of the “Open” node, add a process node with the label “Read the prompt or style 

guide relevant to the assignment to gather your review context.” 

3. To the south of the “Read Prompt” node, add a subprocess node with the label “Read through 

the entire piece once to get a feel for its tone, mood, scope, and goal.”  

4.  To the south of the “Entire Piece” node, add a decision node with the label “Do you have any 

questions for the author?”  

a. To the left of the “Questions” decision node, add a process node with the label “Write 

them down to ask later.”  

Note: Leave this node alone for now, we will reconnect it to the mainline flowchart later.  

5. To the south of the Questions decision node, add a process node with the label “Check 

formatting.”  

6. To the south of the “Formatting” decision node, add a subprocess node and label it “Run 

spelling/grammar check.”  

7. To the south of the “Grammar” subprocess node, add a process node labeled “Read through the 

document again, noting any critiques as you go.”  

8. To the south of the “Critiques” node, add a process node labeled “Compile your comments 

about the big picture of the piece.”  

9. To the south of the “Comments” node, add a process node labeled “Send your feedback to the 

author and provide times you will be available to discuss questions.”  

10. To the south of the “Feedback” node, add a start/end node labeled “End.”  

Now we need to go back in and add an arrow connecting the “Write Them Down” 

subprocess node with the Formatting decision node. Follow these steps:  

1. Click the Write Them Down node once to select it.  

2. Click on the white circle at the bottom of the node (which appears after you 

select it). The circles should now turn green when you hover over the node. 

Reference Figure 18 and Figure 19 to observe the difference between the 

circles when they are white or green. 

Figure 18: White Circles 

Figure 19: Green Circles 
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3. Click and hold your mouse over the bottom-most circle (making sure that it is 

green) and drag your cursor over to the Formatting decision node until you 

see “Glue to Connection Point” on the left-most edge of the node. Reference 

Figure 20 for a visual. 

4. Release your mouse and watch the arrow connecting the nodes take shape.  

5. Click away from the arrow to de-select it.  

We should also label the two diverging paths from the decision node. Follow these steps: 

1. Within the Home tab, click the Text Box button. 

2. Hold down the mouse and drag it down diagonally to create a textbox.  

3. Type “Yes” as the label. 

4. Move the textbox so that it is just above the arrow connecting the 

decision node and Write Them Down. 

Repeat these steps to do the same for the arrow connecting the decision node 

and the Formatting node. Make sure to label this textbox “No.” 

You may have noticed as you were adding nodes that some of them carried over to the next page. We 

can get the whole flowchart on one page by resizing some of the nodes and repositioning them on the 

canvas. Arrange your flowchart any way you like. Your workspace should look something like Figure 22.  

 

Figure 22: Flowchart Check-In 

Figure 20: Glue to Connection Point 

Figure 21: Yes/no Captions 

Yes 

No 
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Changing and Deleting Shapes 
Once you’ve made your flowchart, you may decide that you want to change the way it looks, or that you 

want to delete a step that seems superfluous.  

To begin with, we’ll change Read Prompt to a subprocess node instead of process node. Complete the 

following steps: 

1. Click the Read Prompt node once to select it.  

2. Right click the node to open the menu and click the arrow to the right of Change Shape to open 

that menu as well.  

3. Select the subprocess node, and watch the change occur instantly.  

Now, let’s say that we wanted to delete the End node. Here are the steps we would take:  

1. Click the End node once to select it.  

2. Right click the node to open the menu and select Delete from the list. 

Use the keyboard shortcut Ctrl + Z to undo the deletion of the End node for the purposes of our example 

project. You can also use the Undo arrow (located on the top left side of the screen) to return to your 

last step, just before the change was applied. Similarly, you could use a combination of the Redo arrow 

(located next to Undo) and the Undo arrow to swap back and forth between applying the change and 

removing it—if, say, you wanted to compare how the canvas would look with and without the End node.  

Personalizing Your Flowchart 
The shape of our flowchart is finalized, but it still has the standard Microsoft Visio template colors. For a 

quick look improvement, we’ll change the template’s theme. Complete the following steps to do so:  

1. Click the Design tab in the topmost toolbar.  

2. Click the arrow next to Themes to expand the drop-down menu.  

3. Apply the Parallel theme.  

4. Click the arrow to the right of Theme Colors to expand the drop-down menu. 

5. Select Zephyr.  

We can also adjust connector style and diagram layout—plus resize the workspace to fit the shape of 

the diagram exactly. To adjust connector style and diagram layout, follow the steps laid out in this list: 

1. Select all the nodes in the flowchart by using the keyboard shortcut Ctrl + A.  

Note: If you only wanted to select part of your flowchart, you could do so by clicking and holding 

down your mouse, then dragging it across the screen. This enables you to set the start and end 

points of your selection box manually.  

2. Click the arrow to the right of Connectors and select Straight Lines from the drop-down list.  

3. Select the lines coming in and out of the Formatting node individually and change them to Right 

Angle (located in the same drop-down list).  

4. Click the arrow next to Diagram Layout and select Left to Right from the drop-down list.  

5. To resize the workspace, click the arrow next to Size and select Fit to Drawing from the drop-

down list. 
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Your flowchart should now look like Figure 23, modeled below: 

 

Figure 23: Finalized Flowchart 

Sharing Your Document with Others 
If you are working on a group project, you may need to add other people to your document so that you 

can co-author it in real time. To do so, click the Share button at the top right of your screen. Click Share 

again within the resultant drop-down menu. Then:  

• In the To: field, type in the email address of the intended recipient, then click the arrow to the 

right of the pencil icon and make sure Can Edit is selected.  

• You can type a brief explanation of the document in the Message field to give the recipient 

context for why you are sending them the document.  

• Click the arrow next to Anyone with the link can edit to adjust the link’s settings, such as who 

the link will work for and whether you would like to specify a password or expiration date for 

the link. Be sure to press the Apply button to commit your changes. 

• To send the link, you can either press the Send button, or copy the link to your clipboard and 

send it to the recipient through other means.  

 

                          Figure 24: Share Document Window 

 

                     Figure 25: Link Settings 

If you share the document with others, then you will also need to know how to review, add, and delete 

comments. Review the list below to learn some of the basics of commenting on a Visio document:  

• Click the Comments button on the top right of the screen to open the comments panel.  
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• To add a comment, click the New button, type in your comment, and then press the Post 

Comment button or use the keyboard shortcut Ctrl + Enter.  

• To view a comment, click the speech bubble icon wherever it 

appears in the workspace, or open the comments panel like usual.  

• To reply to a comment, type in the @mention or reply field, then 

press the Post Comment button. You can also press the Cancel 

draft button to change your mind.  

• To edit or delete a comment, right click the ellipsis icon in the upper right corner of the 

comment thread, and then select either Edit comment or Delete thread as appropriate.  

 

                      Figure 27: Adding a New Comment 

 

                Figure 28: Editing or Deleting a Comment

  

Figure 26: Comment Speech Bubble 
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Ch. 3: Exploring Menu Options 
In this chapter, we will explore each of the menu tabs in Visio one by one. For our example project, we 

will create a brainstorming diagram on the benefits of digital polyhedral dice versus physical polyhedral 

dice. Following the completion of this project, we will have created an example of each of the three 

main categories of diagrams as per Microsoft’s website: diagrams, flows, and planning [tools]. 

Brainstorming is typically a behind the scenes process at companies, but it can be very useful for 

arranging your thoughts on a project. If you plan a project out ahead of time, you will oftentimes end up 

with a more focused result. This isn’t all that brainstorming tools are useful for, however—they can also 

be used to document comparisons between finished products.  

Set up the Initial Diagram 
Our first step is to open a Venn diagram template. To do so, follow these steps: 

1. From the home screen, click More templates to see the full list of options.  

2. Scroll down to Venn Diagrams. 

3. Use the Create button to open the very first template, the default Venn diagram.  

Next, we’ll need to establish the shape and contents of the diagram. Complete the following: 

1. Within the palette, locate, add, and open the Venn Diagram Shapes panel.  

2. Click and hold down the mouse while it’s hovering over 2-sets Venn diagram with captions, then 

drag the shape out onto the middle of the canvas. 

3. Double-click the caption on the right side of the diagram to open the textbox and replace the 

placeholder text with the label “Digital polyhedral dice set.” 

4. Repeat Step 3 for the caption on the left side of the diagram, changing the placeholder text 

there to “Physical polyhedral dice set.”  

5. Now, double-click on the green shape in the overlapping area of the two circles to open the 

textbox there.  

a. Enter the following information as a label: “-Contain seven dice -Create a sound when 

rolled -Come in colorful options.” 

b. Use the Enter key on your keyboard to put a line of space between each element 

beginning with a dash. 

c. Use the keyboard shortcut Ctrl + A to select all the text 

d. In the Home tab, click the drop-down arrow next to Font Size, and change all the text to 

pt. 8 so that it will fit comfortably within the shape of the diagram.  

e. Click somewhere outside of the textbox to close it.  

6. Repeat Step 5 for the blue circle on the right side of the diagram but use the following text as a 

label: “-Plays a custom animation when you roll a natural twenty -Enables the GM to see your 

results immediately -Are often cheaper to purchase and featured in sales.” 

7. Repeat Step 5 for the orange circle on the left side of the diagram but use the following text as a 

label: “-Text may be poorly printed or even illegible -Come in different color variations due to 

the creation process, no two sets are alike -May get caught on the side of the dice tray and land 

between two numbers instead of settling on one number.” 
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Your diagram should look something like Figure 29 below: 

 

Figure 29: Finalized Venn Diagram 

Exploring the Home Tab 
Note that the File menu contains standard information which is not unique to Visio. As such, we will 

leave the File menu out of this chapter to focus on more important information. Similarly, we will not be 

covering the Design tab since everything there (save for one button) is used in Ch. 2: Starting a Project 

from a Blank Document.  

Please note also that we will be focusing on the main four tabs (besides Design) that are always visible in 

the toolbar and not any of the tabs that may pop up (when you open an image or shape specifically, for 

instance). Finally, the functions of the buttons in the main four tabs will be explained in groups instead 

of individually, as most of them still provide very standard functions.  

With that covered, the first tab that we’ll be exploring is the Home tab, depicted in Figure 30 below. 

Notice how the tool icons are sorted into groups depending on their functionality.  

 

Figure 30: Home Tab Toolbar 

• Undo and Redo – As mentioned in Ch. 2: Starting a Project from a Blank Document, 

these two buttons can help you either delete a mistake or fix an accidental 

deletion respectively.  

• Cut, Copy, Paste, and Format Painter – The Cut tool removes an instance from your workspace 

but saves a copy of it to your computer’s clipboard.  

o Copy creates a duplicate of the instance on your computer’s clipboard.  

o Paste adds whatever is stored in your computer’s clipboard to the 

workspace.  

Figure 31: Undo and Redo 

Figure 32: Clipboard Tools 
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o Format Painter copies the format of a specific instance so that you can easily reapply it 

elsewhere.  

• Delete – The Delete button will completely remove an instance from your workspace.  

Note: The cut tool combines the functionality of both copy and delete. 

 

Figure 34: Text Decoration Toolbar 

• Text Decoration – Font and Font Size let you customize the text that appears in a textbox, from 

its overall style to its size.  

o Bold, Italics, and Underline are standard program functions as well.  

o Text Color lets you change the color of the text.  

• Align and Rotate Text – Align Text enables you to choose whether your text is left-

aligned, center-aligned, right-aligned, or justified.  

o Rotate Text enables you to automatically rotate a textbox 90 degrees. 

• Create Textbox and Draw Shape – The Create Textbox button lets you place a new 

textbox on the canvas.  

o Draw Shape is similar in function, enabling you to quickly insert a basic 

shape. For more complicated shapes, you will need to reference the 

palette.  

• Shape Fill and Shape Outline – Shape Fill lets you change the color of the interior of 

a shape, whereas Shape Outline lets you change the color of the shape’s border.  

 

      Figure 38: Tools for Use with Multiple Selections 

• Align Shapes and Position Shapes – Align Shapes functions similarly to Align Text, 

except that it reorients shapes instead of text.  

o Position Shapes enables you to distribute the shapes you’ve selected 

either horizontally or vertically, just like you would be able to distribute 

rows or columns in a table. 

Note: These two tools, as well as the other tools in the Home toolbar going forward, require you 

to capture multiple shapes in a selection before you can make use of them. A good rule of 

thumb is that if a tool is greyed out, it cannot be used. Reference Figure 38 versus Figure 39 to 

see the difference between a tool that can be used, and a tool that is greyed out. 

• Bring to Front and Send to Back – These functions enable you to arrange the order 

of instances that are stacked on top of each other. If you dragged a rectangle over 

the text so that it wasn’t visible, for instance, you could use Send to Back to make 

Figure 33: Delete Tool 

Figure 35: Align and 
Rotate Text 

Figure 36: Create 
Textboxes and Shapes 

Figure 37: Shape Fill 
and Outline 

Figure 39: Align and 
Position Shapes 

Figure 40: Layering 
Tools 
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sure that the rectangle appears underneath the text. Bring to Front would do just the opposite if 

you had the text selected instead.  

• Group, Rotate, and Flip – The Group button lets you turn several shapes 

into one selection group, so that you do not have to select them all 

individually to apply changes to them.  

o The Rotate button enables you to rotate shapes in 90-degree increments.  

o The Flip button lets you flip something either vertically or horizontally.  

Exploring the Insert Tab 

 

Figure 42: Insert Tab Toolbar 

• Pictures – The Pictures button takes you to a pop-up window that will enable you to upload an 

image file to your workspace.  

o Online Pictures allows you to quickly search through Bing images and select one to insert 

within your document. The nice thing about this feature is that you can choose to search 

for images that have Creative Commons licenses specifically.  

o Stock Images lets you search for images within Visio’s database, and then insert an 

image of your choosing to the workspace.  

• Text Box and Draw Shape – These two buttons function precisely the same way they do in the 

Home tab.  

• New Comment – The New Comment button will allow you to add a new comment in a location 

of your choosing. I.e., if you wanted to point out a misspelling in a textbox, you could comment 

on that exact textbox.  

• Link – The Link button lets you insert a hyperlink within the document. You can specify whether 

the link goes to a URL, a spot within the document, or even an email address. You can also add 

display text to the URL.  

Exploring the Review Tab 

 

Figure 43: Review Tab Toolbar 

• Check Accessibility – The Check Accessibility button is a neat feature that will inform you about a 

few common accessibility problems if they appear within your document. Missing alternate text 

and default page names are a few examples of issues that this panel would alert you of.  

• New Comment – Functions the same way as it does in the Insert tab. 

• Delete Comment – Lets you quickly delete a comment thread.  

• Previous Comment -- Lets you cycle back to a previous comment in the document, causing your 

screen to jump to the position of that comment. 

• Next Comment – Functions like Previous Comment except that it cycles clockwise instead.  

• Show Comments – The Show Comments button allows you to quickly open the comments panel.  

Figure 41: Group, Rotate, and Flip 
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Exploring the View Tab 

 

Figure 44: View Tab Toolbar 

• Reading View – Takes you to a preview screen in which you have limited editing functionality. 

This screen lets you get a good sense of what your project will look like without guides and aids.  

• Quick Shapes – Enables you to choose whether you want to be able to insert shapes by hovering 

over the directional arrows relative to an instance that is already included in the workspace.   

• Page Breaks – Lets you to decide whether you want to see page breaks in the document.  

• Smart Guides – Enables you to turn positioning guides on or off.   
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Glossary 
Business Process Model and Notation (BPMN) 

– A standard style of graphic that is used to 

depict the processes and relationships of a 

business.  

Connectors – The arrows that link all the nodes 

in a flow chart, indicating their relationships to 

one another.  

Decision – A flowchart node type that causes a 

branch diversion in the main path of the 

flowchart. Decisions are usually answerable by a 

yes or no response.  

Network Diagram – A depiction of the 

relationship between the components that 

make up systems such as computer networks.  

Palette – The toolbar located on the left-hand 

side of the screen in Visio. Offers search 

functionality and access to a variety of shapes.  

Process – A flowchart node type that details a 

step or activity the user must perform. 

Subprocess – A flowchart node that is either a 

sub-step of a pre-existing node, or a pre-

defined (repeated) process.  

Terminators – The start and end nodes of a 

flowchart.  

UML Diagram – A type of diagram meant to 

depict processes and other components that 

make up a software system. UML stands for 

Unified Modeling Language, which is a standard 

form of notation. 

.vsd – The file type name assigned to Visio 

documents.   
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Appendix A: Comparison of the Visio Plans 
Visio is available as part of Microsoft 365, as a monthly subscription, and as a one-time purchase. There 

are four different program versions: Visio Plan 1 and Plan 2, Visio Standard 2021, and Visio Professional 

2021. Plans 1 and 2 are subscription-based, and Standard and Professional are one-time purchase. 

Visio Plan 1 includes the web version of Visio only, whereas Plan 2 includes web and desktop. There is a 

difference of $10 between the two monthly plans. The major difference between the two plans, 

however, is that plan 2 incorporates additional features that are exclusive to the desktop application 

(such as the ability to connect to other Microsoft apps and link to data stored in outside programs).  

According to the Microsoft website, Plan 2 also includes additional functionality in the following areas: 

• Intelligent diagramming (from the inclusion of rulers, layers, and grids to the ability to measure 

how well your diagrams comply with standard diagram practices) 

• User experience and features (from shape effects to touch-screen compatibility) 

• Templates, stencils, and shapes (adds floor plan templates and much more) 

• Accessibility, security, and compliance (adds the ability to edit files from early versions of Visio, 

which are called “.vsd files”) 

• Standards support (adds support for processes like BPMN) 

Something else that’s nice about the subscription plans is that you can conduct a free one-month trial 

before you commit to a purchase. Overall, though, the subscription plans are relatively similar to the 

one-time purchase plans. Visio Professional 2021 looks a lot like Visio Plan 2, and Visio Standard 2021 is 

similar to Visio Plan 1. The major difference between the subscription plans and the one-time purchase 

plans is the cost when considered in the long run. At $309.99, Visio Standard 2021 is about 61 months of 

Visio Plan 1. Visio Professional 2021 is $579.99, which is about 38 months of Visio Plan 2.  

Visio Professional 2021 differs from Visio Standard 2021 in the following areas:  

• Standards support (not included in Visio Standard at all) 

• Intelligent diagramming (the ability to compare your diagrams against industry standard 

diagrams) 

• Templates and shapes (floor plan templates and more, just like in Visio Plan 2)  

• Collaboration and sharing (the ability for multiple people to work in the document and see 

where their co-authors are making changes)  

• Connecting diagrams to data (the ability to link and auto-refresh data from outside sources)  

In the end, the correct version of Microsoft Visio for you depends upon three factors: 

1. What program capabilities you’ll need to create effective diagrams 

2. How frequently you will be using the program throughout the year 

3. The total number of years you will be using the program 

If you will be using the program for a long time to come, a one-time purchase option may be worth the 

investment. Otherwise, one of the subscription plans is likely a better option, or even the package deal 

with Microsoft Office 365.   
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Appendix B: Further Reading 
BPMN 

1. How to Use BPMN 

2. Creating a BPMN-Compliant Process 

Brainstorming  

1. Creating a Diagram 

2. Tools for Making Diagrams 

3. How to Use Brainstorming Software Effectively  

Organization Charts 

1. Creating an Organization Chart 

2. Autogenerating an Organization Chart 

Process Mapping 

1. What is Process Mapping?  

2. Creating a Process Diagram  

3. Common Types of Flowcharts  

UML Diagrams 

1. Creating a UML Diagram  

2. Creating a UML Sequence Diagram  

https://www.microsoft.com/en-us/microsoft-365/growth-center/resources/the-guide-to-using-bpmn-in-your-business
https://go.microsoft.com/fwlink/p/?LinkID=2113049&clcid=0x409&culture=en-us&country=US
https://support.microsoft.com/en-us/office/create-a-brainstorming-diagram-642706c0-7e63-463b-8aa8-a9aa67367989?ui=en-us&rs=en-us&ad=us
https://support.microsoft.com/en-us/office/five-great-tools-for-making-brainstorming-diagrams-in-visio-92d2505b-8187-4134-b1a9-16e7a20720e8
https://www.microsoft.com/en-us/microsoft-365/business-insights-ideas/resources/use-brainstorming-and-software-for-effective-planning
https://support.microsoft.com/en-us/office/create-an-organization-chart-in-visio-abb3dd17-2692-439f-9945-3a015767d96a?ui=en-us&rs=en-us&ad=us
https://support.microsoft.com/en-us/office/create-an-organization-chart-automatically-from-employee-data-8f2e693e-25fc-410e-8264-9084eb0b9360?ui=en-us&rs=en-us&ad=us
https://www.microsoft.com/en-us/microsoft-365/business-insights-ideas/resources/succeed-with-process-mapping
https://support.microsoft.com/en-us/office/process-diagrams-in-visio-f064cd25-d7d5-47b8-87e1-ecb3c39cc165?ui=en-us&rs=en-us&ad=us
https://www.gliffy.com/blog/your-guide-to-the-most-common-types-of-flowcharts
https://support.microsoft.com/en-us/office/uml-diagrams-in-visio-ca4e3ae9-d413-4c94-8a7a-38dac30cbed6?ui=en-us&rs=en-us&ad=us
https://support.microsoft.com/en-us/office/create-a-uml-sequence-diagram-c61c371b-b150-4958-b128-902000133b26?ui=en-us&rs=en-us&ad=us

